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1 Mendeley in not even 10 steps 
 

Mendeley is a free reference manager that helps you keep references and literature for your 
research organized. You can: 

 
• Create and manage citations of books, articles, and more 
• Import citations from online resources and publisher’s websites 
• Automatically extract metadata from imported PDFs 
• Collaborate with other researchers online 
• Highlight and annotate papers and share those notes with others 

 
Because you have a desktop version and an online version that synchronize you can always work 
anywhere, from any device and have your library up to date. 2GB of online storage is available. 

1.1 Go to www.Mendeley.com and register 

Two important things: 

1. Create your account using your personal mail adres: name@yahoo.com, name@gmail.com 
2. Install Mendeley desktop in your documents folder, this way it is easier to back-up your 

references and more important your pdf’s. 
 
1.2  Download Mendeley desktop  

http://www.Mendeley.com/download-Mendeley-desktop/ Install Mendeley desktop from 
the downloaded file. 
From the my library tab on the online library go to the button ‘web importer’ to drag the ‘save to 
Mendeley’ button to the bookmarks toolbar of your browser(s). You can also do this later from the 
Tools menu in Mendeley desktop. 
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1.3 Find your browsers bookmark toolbar 
Firefox : right-mouse-click the top bar of your browser, and tick the box for ‘bookmarks toolbar’ 

 

 

Chrome: click the menu icon (see red box) move your mouse to ‘bookmarks’ and  
‘show bookmarks toolbar’ activate this. 

 

 

Internet Explorer : right-mouse-click the top of your browser, and tick the box for Favorites bar 
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1.4 Install the Word plugin 
 

Go to the tools menu in the 
desktop version. Also you can 
select another plugin for other 
word processors. 
 

 

1.5 Start building your library  

Importing references with the help of the save to Mendeley button from for example Elsevier, Web of 
Science, ACM or Wiley online library. The first time in any session you want to import a reference you 
will be asked to sign in with your Mendeley account.  Some examples and notes below: 

 

From Science Direct by Elsevier.  

If you have a search with 6 results, and click “save to Mendeley”, the export of all references on your 
screen will start. You can then select the ones you really want from the download list on your screen. 
Do NOT do this with a result of 12,354 articles! refine your search, or go to one of the articles on your 
screen and save that one. 
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From Web of Science: 

To use ‘save to Mendeley’ in Web Of Science, you need to be registered with WOS and be signed in. 

 
 
If you get stuck, use the option “full text from publisher”  to find the article and get a good “save” of 
metadata from the publishers website. 
 
Another shortcut:  
Type http://dx.doi.org/ in your browser, add the article doi 10.1016/j.habitatint.2015.01.018 
And you have created the fastest route to the publishers website, and hopefully full text  
http://dx.doi.org/10.1016/j.habitatint.2015.01.018 

 

From ACM digital library 
 
The Mendeley web importer will start and offer you the option to include the pdf, and to select the 
library folder in which you want to ‘add’ this reference. 
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View in Mendeley Desktop by using the “view in Mendeley desktop” button, do not skip this!. 
 
You have now switched from the bibliographic database for literature to Mendeley desktop. 
 
Mendeley now shows you the record, highlighted so you can check and edit the record, and add the 
pdf by clicking the blue download sign (pdf is not always added directly) if the pdf does not load, save it 
manually in your Mendeley pdf (watched) folder. 
 

 
 

You may have noticed : the pdf is not always automatically imported with the reference.  
 

Drag and drop a pdf to create a reference 
 

• Previously saved pdf’s are easily imported into Mendeley. 
• Open the folder for these pdf’s in a new screen, now drag-and-drop the pdf from the folder to 

the middle pane of the Mendeley desktop library. 
 
Do it yourself record  
If importing information via Save to Mendeley or pdf does not work, you can copy-paste all information 
on the book, thesis, article from the web-page you are on, into the Abstract or Title field from an empty 
mendeley record [desktop library: file, add entry manually]  and distribute the information into the 
designated fields, Title, author, place, publisher, year pages, url, doi. etc. 
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1.6 Create your Watched Folder  
 
In your document folders create a new folder you want to be the dedicated pdf folder for automatic 
reference import. Next from your desktop library, go to: file, watch folder, navigate to the just created 
folder to tell Mendeley your preference. 
 
Save a pdf in this specific folder that you have designated your watched folder and your references will 
be added automatically to your library. 
 
Please check this, because the pdf needs to contain enough metadata to form a reference. 
 

  
 
 

This is how you add a pdf to an already imported reference. In ScienceDirect by Elsevier this also works 
for the ‘download multiple pdf’ option.  
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1.7 Inserting citations and references – two ways 
 

Go to the reference tab in Word, click import citation and use the search bar to find the reference 
you want to insert in your work, type author or a distinguishing title word. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

from word, references tab, click insert citation, then on the search bar click GO TO MENDELEY to 
select your reference, 

 
 
 
 
 
 
 

Then you will get the “send citation to plugin” button, 
meaning send citation to Word button. This way you can also combine two references in one 
citation. 

 
Mendeley will only add the citation, without reference to your word document. You can add all 
citations for your paper before adding the references / bibliography with one click of a button. 
Or if you choose, ‘ insert citation’ first, then ‘insert bibliography’ and from now on Mendeley will 
add citation and reference simultaneously. 
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1.8 Change your citation and output style by using the drop down menu in Word 
 

 
 

Or the View menu in Mendeley desktop 
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1.9 Edit your citation 
 

In the flow of writing a sentence you may want 
to place the name of an author outside the 
brackets.  To achieve this simply click the 
citation and immediately upon doing this your 
‘insert citation’ button now says ‘edit citation’. 
You can now type a bracket before the year and 
remove the one placed before the author’s 
name.  
 
When you have finished, put your cursor 
elsewhere in the text and you will be asked if 
you want to keep this manual edit. 

 
 

 
 
 

 
 
Lateron it is possible to undo this simply by clicking on the citation and use the “undo edit” 
button. This Mendeley insert citation button has a multi-purpose function ! 
 
To completely exclude the author; click the citation, click the now so called ‘edit citation button’ put 
your cursor on the author’s name in the search bar and click the button “suppress author” this leaves 
only the Year. The Prefix and Suffix option add text before the author and after the year. 
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2 Mendeley things to know 
 
All online resources and help by Mendeley  http://resources.Mendeley.com/ 

2.1 Research databases 

If you use research databases like Scopus, Web Of Science, Geobase or CAB for your research, where 
the Universities Journal subscriptions are integrated with the database, you may have to click a few 
times to get to the publishers site before you can download the full text pdf with the necessary 
metadata.  Or type http://dx.doi.or/ in a new browser tab; add the doi 
http://dx.doi.or/10.1016/j.isprsjprs.2010.06.005  and you will go straight to the publisher’s website 

 
Importing data with the SFX banner at the top of your screen, usually does not work. Importing the 
references from the original publisher’s website gives the best metadata. 

2.2 The DOI saves the day 

If you have trouble exporting your references, try to find the DOI (Digital Object Identifier) of your 
article, put it in a New Reference (File, Add entry manually) and the Lookup function will complete 
your reference! 

 
 

2.3 Literature Search in Mendeley Crowd-sourced online research catalogue 

 
You can use the literature search – bar in Mendeley. 
 
Which database are you using with this search option? 
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Please be aware, this is not the search within your own library! 
 

- It accepts Boolean operators, AND, OR and Not 
- Truncation is possible: mode*ing for modelling or modeling 
- Just tick the dot before one of the found references to save it to your library 

 
Be aware that most publication types are not properly recognized, given as 

“generic” in the database. Use the look-up function with each reference to complete the reference. 
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3 Organizing your Mendeley library 
3.1 Import other libraries 

 
Starting from Endnote: 

1. Select all references 
2. Go to ; File, and Export 

 
 

3. Select location : save in 
4. Choose : file name 
5. Save as type: XML 
6. Outpute style : Endnote Export OR RIS 
7. Tick the box: export selected 

references 
8. Save 

 
Go to Mendeley: 
 

1. Go to: File, import, Endnote OR RIS 
2. Navigat to the fil you have just save 
3. .. and import 
4. Mendeleyev will chek for duplicates 

 
  

Endnote or other libraries can be 
imported, into Mendeley desktop 
library, take the next few steps:   
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3.2 Create folders & sub-folders and search the full-text of your library 
 

 

Right click anywhere in the left hand pane 
to create folders and sub-folders. You can 
drag and drop files into folders from 
anywhere. We recommend starting with 
search to help find things fast. The real 
usefulness of folders is for reducing the 
scope of your search 

 

 
Search for a keyword, titlewords, authors 
in the top rigth searchbar to find 
documents instantly as you type. 
 
This searchbar is context sensitive, so if 
you are reading a pdf, it will search the full 
text of the pdf (pdf type permitting) 
 
The search includes global notes and tabs 
by default and you can filter specifically by 
clicking the filter arrow. 
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3.4 Where are my pdf’s? 
 

 

 
A right mourse click on a saved pdf, 
from your desktop library wil tell you 
whare Mendeleyev has saved it. 
 
See 3.6 for file organization 

 

3.5 Read, mark and add sticky notes to the saved articles 
 

If you double click one of the references in your Mendeley desktop the pdf will open, you can read, 
make notes, use the highlighter. Etc. 

You can share this paper with annotations with your, supervisor or professor     
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3.6 Automatically organizing your pdf’s 
 

 

From the Tools menu, select options and the 
File organizer tab. You can ask Mendeley to 
sort, rename and store your pdf in specific 
folders ! simply drag the field name tags to 
where you want them. 
First tick the “organize my files” option, then 
choose 

- Sort files 
- Rename documents 
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4 Document-types and output-styles 

4.1 Different document types 
Most used is the journal article, and if your paper and reference comes from one of the larger databases 
like Springer, Elsevier or Web of Science your reference and citation will be complete. Document types 
such as reports, msc and phd theses and especially websites may take some attention. In general, 
always check the reference you have just imported to see if al information is there.  

When using the ‘save to Mendeley’ button on a website you have been using in your research the 
author of the website does nog appear. As author of a webpage you usually use the Organization or 
institution that hosts the webpage. In case of a blog you name the person writing the blog.  

 

If you manually add the name of the institute, department, organization as author of the webpage, your 
citation wil be clearer and the reference will make more sense. While typing the name of the author 
you will be offered the option of marking it as an institution/organization.  

If the name of the organization has more than one part add a comma [ , ]  at the end, this will keep the 
name in the same order and Mendeley will not try to change it into a family name with initials.  
For example “The World Bank” will not change into “Bank, T.W.” if you add the [ , ] at the end. 

MSc or PhD theses 

To clearly recognize a MSc or a PhD theses you may want to add (MSc thesis) or (PhD thesis) just after 
the title in your Mendeley record. You can use both ‘Book’ and ‘Report’ as record type for these 
publications in Mendeley. 
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4.2 Output styles 

The APA style is one of the most used output and writing styles, the reference list generated following 
this style is very elegant and complete. Please see this schedule on how may authors are used in 
citations of papers with more than one author. 
Citation schedule for APA:  

 

If you prefer to have only one author with each citation, select for example: 

- Chicago : manual of style 16th edition or  
- Harvard : imperial college London, as an output style.  

 

Others prefer a style called Numbered where each citation is just symbolized by [3] for 
example instead of the author’s name.  Also the well-known journal  “Nature” uses a 
numbered style for its publications 

 

Have a good look at both citations and references before you change your output style. 
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5. Mendeley and BibTex / LaTeX 
 

5.1 Export from Mendeley to BibTex 

http://libguides.mit.edu/content.php?pid=241351&sid=1992274 
“How do I export from bto BibTeX? 
Open Mendeley, and within "My Library" found on the left, select references that you would like to 
export to BibTeX. In the drop-down menu in the toolbar at the top of the screen, click "File --> Export" 
(or ctrl-E if you use keyboard shortcuts) and in the dropdown list of file types, chose "Save as type: 
BibTeX" and save to the same location as the LaTeX file. 
 
If you're working with Mendeley on a PC and your manuscript is on Athena, you'll need to save the 
BibTeX export to your hard drive and use FTP or another file transfer method to transfer the file to the 
correct directory in your Athena space. 
 
To link the bibliography file that you just downloaded to your document, you need to enter two 
commands: \bibliographystyle{style} should go just inside your \begin{document} command. 
style.bst is the name of the style file dictating the format of your bibliography (see  How do I change 
the format of the bibliography? below). 
 
\bibliography{filename} should go wherever you want LaTeX to generate the bibliography. 
filename.bib is the name of the file that you just downloaded from RefWorks containing your 
exported references. “  (Green, n.d.) 
 

5.2 Automatically create a BibTex files 
Also from the Tools menu, and options, BibTeX tab you can set Mendeley to automatically create a 
BibTex file for each reference in the library. 
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6. Mendeley online 
 

Your online Mendeley library serves as backup and can act as your work platform when you do not 
have your ‘desktop computer’ at hand. 
 
You can save references, maybe not always with pdf  but the synchronization option of Mendeley will 
import them into your desktop version when you start-up the next time. 
 
Your online storage capacity for the free Mendeley edition is 2GB 
 
Some editing options are also available in the online version 
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6.1 Create a group 
 

 

In the free version of Mendeley you can make only one 
private group of 3 people to share references and your 
work. You can however make more open groups to 
share references. In these open groups you can share 
references when working on a joint project. But you 
cannot share documents because of copyright. 
 

 
 

 

 
Move references to this group.  
 

- From your desktop library 
- Or From the online Mendeley dash 

 

 
 
6.2 Participate in groups 
 

 

Already a lot of people with 
Mendeley account have joint 
groups of their interest, it’s 
possible to search available groups 
for you topic and see if useful 
discussions are going round. You 
can ask to join if it is a closed 
group, or opt to follow their work. 
 
The option to browse groups 
offers a nice start to see what’s 
available. 
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6.3 Create your own profile 
 

To work with others, share your experience or build your own profile you can create a Mendeley 
profile on your online account page, click your name as mentioned after login.  Now you can edit 
you profile, change who you want to follow etc. 
 

 
 

Adding your papers will be offer to you by Mendeley, and of course you can add papers yourself. 
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By using the DOI in your url colleagues from all over the world with access to e-journals can find the 
papers you’re listing on your profile. To share these papers the use of author’s copies and pre- 
publication versions is usually allowed by publishers. Open Access papers know no restrictions in this 
sense. 
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